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Abstrakt 

 

POKRÝVKOVÁ, Katarína. Využitie platformy Arduino v experimentoch na hodinách 

fyziky. 

[Bakalárska práca]. Univerzita Komenského v Bratislave. Fakulta matematiky, fyziky 

a informatiky. Katedra didaktiky matematiky, fyziky a informatiky. Vedúci bakalárskej 

práce: doc. RNDr. František Kundracik Csc. Stupeň odbornej kvalifikácie: Bakalár v 

študijnom programe Učiteľstvo predmetov fyzika a informatika. Bratislava. 2020. 

58 s. 

Práca sa venuje problematike používania digitálnych meracích systémov na vyučovaní 

fyziky. V krátkosti analyzuje merací systém Coach a skúma možnosti vytvorenia meracích 

prístrojov na platforme Arduino. Ponúka podrobný návod na zostrojenie digitálneho 

teplomera pomocou Arduina, a návrh aktivít na vyučovanie fyziky, v ktorých sa teplomer 

využíva. 

 

Kľúčové slová: arduino, merací systém, teplomer, meranie, vyučovanie fyziky 

 

  



Abstract 

 

POKRÝVKOVÁ, Katarína. Using the Arduino platform in school physics experiments. 

[Bachelor thesis]. Comenius University in Bratislava. Faculty of Mathematics, Physics and 

Informatics. Department of Didactics in Mathematics, Physics and Informatics. Supervisor: 

doc. RNDr. František Kundracik Csc. Grade of qualification: bachelor in study program 

Teaching of Subjects Physics and Informatics. Bratislava. 2020. 

58 pages. 

This thesis deals with the use of digital measurement systems in secondary education 

physics curriculum. We shortly analyze Coach, one such system, and explore possibilities 

of building measurement systems based on the Arduino platform. We offer detailed 

instructions for crafting a digital thermometer based on Arduino and propose activities to 

perform during physics lessons using this thermometer. 

 

Key words: arduino, measurement system, thermometer, measurement, physics curriculum 
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Úvod 

Počas štúdia na FMFI sa učím o rôznych stratégiách používaných na vyučovaní fyziky na 

základnej a strednej škole, pričom najväčší dôraz je kladený na tvorbu poznatkov a 

vyučovanie, ktoré rozvíja prírodovednú gramotnosť a bádateľské zručnosti. 

Úlohou žiakov pri takomto spôsobe vyučovania je byť aktívnymi experimentátormi, 

objavovať prírodné javy cez vlastnú skúsenosť a overovať nadobudnuté vedomosti v praxi. 

Takéto vyučovanie je náročné nielen na organizáciu, ale hlavne na pomôcky, ktoré musia 

byť dostupné všetkým deťom, alebo aspoň každej menšej skupine. Skupín môže byť podľa 

druhu aktivity a počtu detí v triede mnoho a pri aktivitách, kde vyžadujeme samostatnú 

prácu alebo prácu vo dvojici, je často nutné požiadať žiakov, aby si priniesli vlastné 

pomôcky. Takto sa to dá robiť, keď poprosíme žiakov, aby si priniesli plastelínu alebo 

baterku, bude to však horšie pri pomôckach ako je multimeter či digitálny teplomer. Pokiaľ 

škola nie je vybavená dostatočným množstvom týchto pomôcok, učiteľ je značne 

limitovaný v tom, ktoré merania a experimenty môže so žiakmi robiť. 

V súčasnosti existujú meracie systémy, ktoré sa používajú na školách na Slovensku. Takéto 

zariadenia dokážu robiť množstvo meraní podľa toho, ktoré senzory sú zapojené, a 

spracovávať namerané dáta aj z viacerých senzorov naraz. Vykreslia vám graf, nafitujú ich 

funkciou, dokonca vedia kombinovať dáta z rôznych meraní a z rôznych senzorov. Dajú sa 

používať na meranie rýchlosti zvuku, zrýchlenia, či magnetického poľa, čo by bolo bez 

pomoci digitálnych senzorov nemožné, a značne prispievajú ku kvalite vyučovania.  

Žiaci sa najlepšie učia vlastným zážitkom, preto sa snažíme viesť ich k samostatnému 

aktívnemu bádaniu. Na to ale potrebujeme takých meracích prístrojov značné množstvo, na 

rozdiel od situácie, kedy učiteľ robí pred triedou demonštračný experiment a stačí mu 

jeden. Nakúpiť meracie systémy v dostatočnom množstve je nákladné a školy sa môžu 

rozhodnúť, že nechcú investovať toľko financií iba do vybavenia fyzikálneho laboratória. 

Ak chce učiteľ v tom prípade naďalej robiť zložitejšie merania a chce mať zapojených 

všetkých žiakov, musí nájsť lacnejšiu alternatívu.  

Cieľom mojej práce je analyzovať význam merania a aktívneho bádania na hodinách 

fyziky a získať predstavu o meracích systémoch, ktoré nám v tom môžu pomáhať. Ďalej 

ponúkam učiteľom alternatívu vo forme vlastných meracích prístrojov, a návod na 
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zostrojenie digitálneho teplomera na platforme Arduino. Na záver práce prikladám návrh 

na aktivity vo vyučovaní fyziky realizované s použitím tohto teplomera.  
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1 Experimenty a merania na hodinách fyziky 

1. 1 Experiment vo vyučovaní fyziky 

V súčasnosti sa v prírodovednom vzdelávaní kladie dôraz na rozvíjanie prírodovednej 

gramotnosti. „Prírodovednú gramotnosť chápeme ako schopnosť používať vedecké 

poznatky, získavať nové vedomosti, vysvetľovať prírodné javy, identifikovať otázky a 

vyvodzovať dôkazmi podložené závery pre pochopenie a tvorbu rozhodnutí o svete prírody 

a o zmenách, ktoré v ňom nastali v dôsledku ľudskej aktivity.” (Lapitková, 2015 s. 7)  

Táto charakteristika sa ďalej zvykne premietať do troch zložiek 

• prírodovedné predstavy, 

• prejavy vedeckého postoja k realite, 

• spôsobilosti vedeckej práce. 

 

Prírodovedné predstavy znamenajú prevažne znalosti, ktoré žiaci majú o prírode, jej 

zákonoch a javoch v nej prebiehajúcich. Je to obsah prírodovedného vzdelávania vo 

vedomostiach a schopnostiach žiakov. 

Prejavy vedeckého postoja k realite zase súvisia s prístupom žiakov k realite, ktorú 

vnímajú okolo seba. Je to schopnosť zaujímať sa o javy, ktoré pozorujú, klásť otázky a byť 

zvedaví. 

Spôsobilosti vedeckej práce sa spájajú s procesom poznávania a je úlohou pedagógov ich 

u žiakov rozvíjať. Patria tam: 

• pozorovanie, 

• meranie, 

• experimentovanie, 

• formulácia hypotéz, 

• interpretácia dát, 

• konštruovanie tabuliek a grafov, 

• tvorba záverov a zovšeobecnení. 

(Lapitková, 2015 s. 8) 
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Budem sa ďalej venovať empirickým metódam poznávania, ktorými sú 

• pozrovanie, 

• meranie, 

• experiment. 

 

Pozorovanie 

Javy a veci okolo seba pozorujeme každý deň. Vo vyučovaní fyziky máme pod týmto 

pojmom na mysli uvedomelé pozorovanie javov, ktoré nám dáva možnosť odhalovať 

skryté súvislosti či napĺňať vzdelávacie ciele. 

Na hodinách fyziky môžeme pozorovať napríklad: 

Dopplerov jav – na výlete stojac pri ceste sa započúvame do zvuku okoloidúceho auta. 

Lom svetla – zdanlivá hĺbka, ceruzka v nádobe s vodou – javy z geometrickej optiky 

súvisiace s lomom a s odrazom svetla. 

Interferencia svetla – pri odraze od CD média – pri odraze monochromatického a bieleho 

svetla. 

(Demkanin, 2006 s. 15) 

Meranie 

Fyzika objekty a javy nielen pozoruje, slovne opisuje a kvalitatívne vysvetľuje, ale každú 

vlastnosť objektu sa snaží určiť aj kvantitatívne - stanoviť jej veľkosť. Kvantitatívne 

vyjadrená vlastnosť objektu sa nazýva fyzikálna veličina. Meranie je porovnávanie 

meranej hodnoty s istým štandardom, s jednotkou fyzikálnej veličiny. Skladá sa z číselnej 

hodnoty a jednotky. (Demkanin, 2018 s. 55) 

 

Experiment 

Experiment má nezastupiteľné miesto na vyučovaní fyziky. Používajú ho vedci pri 

overovaní hypotéz a cieľom učiteľa je reprodukovať taký postup so žiakmi, čím rozvíja 

spôsobilosti vedeckej práce a pomáha žiakom lepšie pochopiť fyzikálne súvislosti.  

Existuje viacero delení fyzikálnych experimentov. Venujme sa rozdeleniu z hľadiska 

použitých prostriedkov a organizácie. Podľa štyroch kritérií ich môžeme deliť na: 
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1. Demonštračné experimenty 

2. Frontálne experimenty 

3. Skupinové experimenty 

 

4. Domáce experimenty a pokusy s jednoduchými pomôckami 

5. Experimenty a použitím laboratórnych prostriedkov 

6. Počítačom podporované experimenty 

 

7. Reálne experimenty 

8. Modelové experimenty 

9. Myšlienkové experimenty 

 

10. Laboratórne práce 

11. Dlhodobé pozorovania a merania 

12. Terénne experimenty 

   (Demkanin, 2006 s. 35) 

Všetky typy experimentov majú svoj význam a miesto vo vyučovaní. Moja práca sa venuje  

pomôckam na reálne, počítačom podporované experimenty. Môžu byť realizované 

frontálne, avšak výhoda použitia meracieho systému, alebo digitálneho senzora s 

Arduinom, je ich dostupnosť. Práve preto sú ideálne pre skupinové experimenty, kde je ich 

potrebné veľké množstvo, aby mohlo pracovať čo najviac žiakov. Venujme sa ďalej 

počítačom podporovaným experimentom. 

1.2 Počítače na vyučovaní fyziky 

Počítače dnes neodmysliteľne patria do nášho každodenného života. Uľahčujú nám život, 

pomáhajú nám byť efektívnejšími v práci a predovšetkým nám dávajú nové možnosti. 

Odvetvie informatiky sa vyvíja extrémne rýchlo, a jeho vývoj sa odzrkadľuje vo vede aj 
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komerčnej sfére. To isté sa žiaľ nedá povedať o počítačoch a technike v školstve. Síce je 

zvykom, že školy na Slovensku majú informatickú učebňu vybavenú dostatočným 

množstvom počítačov, ich použitie žiaľ zatiaľ takmer absentuje v ostatných predmetoch.  

„Prírodovedná zložka všeobecného stredoškolského štúdia ponúka viacero možností pre 

rozvoj a využitie zručností žiakov v oblasti informačno-komunikačných technológií. 

Nezastupiteľnú úlohu má pri počítačom podporovaných meraniach a experimentoch a pri 

modelovaní javov.“ (Demkanin, 2006 s. 7)  

Príklady použitia počítača na fyzike sú napríklad spracovanie informácií. V textových 

editoroch a prezentačných softvéroch sa dá manipulovať s veľkým množstvom dát a triediť 

ich do zmysluplných štruktúr. Ďalej používanie elektronickej pošty, či iných 

komunikačných kanálov umožňuje efektívnu komunikáciu a spoluprácu medzi študentami 

či učiteľmi. Simulačný softvér nám dáva možnosť priblížiť žiakom javy, ktoré nemôžu 

vidieť na vlastné oči (napríklad rozpad jadier atómov), alebo ktoré vyžadujú level 

abstrakcie (elektrický náboj, prúd elektrónov). Počítačovým modelovaním môžeme 

„zrealizovať” aj ťažko realizovateľný alebo nerealizovateľný experiment. 

Samostatnou kapitolou sú meracie senzory. Použitím počítača dokážeme zbierať dáta tam, 

kde by to ručne nebolo možné, napríklad počas veľmi krátkeho, alebo veľmi dlhého 

časového intervalu. Meracím systémom budeme v práci nazývať zariadenie schopné 

zaznamenávať a spracovávať údaje zo senzorov.  

1.3 Meracie systémy Coach 

Najrozšírenejším meracím systémom na Slovensku je Coach. Vyvíja ho Centre for 

Microcomputer Applications (skrátene CMA) Univerzity v Amsterdame. Ich cieľom je 

obohatiť STEM (Science, Technology, Engineering, Mathematics) vzdelávanie o 

inovatívne a atraktívne technológie. Vyvíjajú špecializovaný hardvér na vyučovanie 

prírodných vied spolu s aplikáciami pre PC a tablety s projektami pripravenými rovno na 

použitie v triede. 

Na Slovensku sa systém Coach používa a vyvíja od roku 1990. Školy majú možnosť si 

zariadenia Coach buď samostatne kúpiť alebo sa prihlásiť do rôznych projektov, ktoré 

zastrešujú prevažne univerzity. 
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Napríklad v roku 2003 sa uskutočnil projekt Infovek katedry didaktiky FMFI UK, kedy sa 

uskutočnili školenia pre učiteľov a niekoľko desiatok základných škôl dostalo zariadenia 

CoachLab II. Podobne v roku 2014-2015 to boli zariadenia MoLab v projekte Dielne. 

Naposledy v roku 2019 to bol projekt IT Akadémia, kedy sa na 90 základných a stredných 

škôl dodali zariadenia VinciLab a uskutočnili sa aj školenia. (Demkanin, 2020) 

V ďalšom odseku sa venujem analýze vybraných meracích interfejsov Coach. 

1.3.1 CoachLab II+ 

„Merací panel CoachLabII+ je stavaný pre súčasné i budúce generácie počítačov, je 

vybavený vlastným riadením a vyrovnávacou pamäťou. Je to multifunkčný interfejs určený 

na počítačom podporované meranie a riadenie systémov. Zabezpečuje on-line meranie so 

zobrazovaním meraných dát na monitore počítača v reálnom čase. CoachLab II+ je 

vybavený vlastným mikroriadením a FLASH pamäťou umožňujúcou updatovanie interného 

systémového softvéru.” (Demkanin, 2006 s. 41) 

Na trhu je od roku 2004, je dodnes používaný, a považovaný za najpraktickejšie riešenie v 

laboratóriu. Výhoda CoachLab II+ je hlavne široká paleta senzorov, pričom môže mať 

zapojených až 6 senzorov naraz. Je nutné používať ho spolu s počítačom, čo na druhej 

strane znamená, že nepotrebuje žiadnu vlastnú batériu, ktorú by bolo treba po niekoľkých 

rokoch meniť. 

Je vybavený dvoma vstupmi pre analógové BT senzory, dvoma digitálnymi BT vstupmi a 

dvoma analógovými 4 mm koncovkami (obr. 1). Dokáže naraz spracovávať merania zo 

všetkých 6 snímačov s maximálnou vzorkovacou frekvenciou 100 000 Hz. 

Na meranie s CoachLab II+ je potrebný PC a softvér Coach 6 6.32 alebo novší. Do 

počítača sa pripája prostredníctvom USB. Softvér rozpozná pripojené senzory a  je možné 

spustiť meranie alebo ovládať nejaký zo štyroch výstupných kanálov s napätím 0V / +12V. 

(Kedzierska, 2014) 
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Obr. 1 CoachLab II+,  

zdroj: https://webshop-english.cma-

science.nl/_clientfiles/products/CMA_Interfaces/m_006p.jpg 

 

Cena CoachLab II+ je 307,50 eur. (CMA, 2020b)  

 

1.3.2 VinciLab 

VinciLab (obr. 2) je mobilný grafický merací systém, ktorý sa dá používať buď samostatne 

alebo spolu s počítačom a tabletom, a to v triede či v teréne. Vyrába sa od roku 2013. 

Obr. 2 VinciLab, zdroj: https://webshop-english.cma-

science.nl/_clientfiles/products/CMA_Interfaces/m_001.jpg  

 

Založený na operačnom systéme Linux, s dvoma procesormi, 8GB vnútornej pamäte a 5” 

dotykovým displejom je meracím systémom a počítačom v jednom. Na meranie 

https://webshop-english.cma-science.nl/_clientfiles/products/CMA_Interfaces/m_006p.jpg
https://webshop-english.cma-science.nl/_clientfiles/products/CMA_Interfaces/m_006p.jpg
https://webshop-english.cma-science.nl/_clientfiles/products/CMA_Interfaces/m_001.jpg
https://webshop-english.cma-science.nl/_clientfiles/products/CMA_Interfaces/m_001.jpg
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nepotrebujeme nič ďalšie, a dá sa zobrať kamkoľvek do terénu. Z toho vyplývajú rovnako 

nevýhody, ako je závislosť na batérii, ktorá má obmedzenú životnosť, a tiež (hlavne kvôli 

displeju) vyššia cena. Pri aktívnom používaní by mala batéria vydržať 6 hodín a jej 

životnosť je niekoľko rokov. 

Rozlíšenie displeja je 800x480 px, k počítaču sa dá pripojiť pomocou USB kábla alebo 

bezdrôtovo cez Wi-Fi alebo Bluetooth. Senzory sa k nemu dajú pripájať cez štyri 

analógové konektory a dva digitálne. Súčasťou je vstavaný akcelerometer a mikrofón. 

S VinciLabom sú kompatibilné BT senzory. Ovládajú sa predinštalovanou aplikáciou 

Coach, alebo po pripojení do PC v programe Coach 7 LITE (zadarmo) alebo Coach 7 

(platená verzia). Pri používaní vstavanej aplikácie sa VinciLab ovláda pomocou 

dotykového displeja a hardvérového tlačidla. Dá sa tiež používať spolu s tabletom cez 

Android aplikáciu Coach 7. 

Prostredníctvom dedikovaných desktop aplikácií sa dá zariadenie nastavovať, 

konfigurovať pripojenie k PC, pracovať so súbormi, pozerať videá, či surfovať na 

internete. V aplikácií Coach sa dajú v reálnom čase sledovať údaje zo senzorov a 

vykresľovať grafy, ponúka nástroje na spracovanie dát a vytváranie a otváranie 

predpripravených aktivít pre žiakov. (Kedzierska, 2019a) 

Cena VinciLabu na oficiálnej stránke firmy CMA je 442 eur. (CMA, 2020e) 

 

1.3.3 WiLab 

WiLab (obr. 3) je jednoduchý data-logger na zbieranie dát. Z rodiny Coach interfejsov je to 

najnovší, na trh vstúpil v roku 2019. Oproti predchádzajúcim modelom pribudla možnosť 

zaznamenávať dáta v reálnom čase bezdrôtovo do počítača, čo vie byť veľmi praktické 

oproti ťahaniu káblov po celej triede. 
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Obr. 3 WiLab, zdroj: https://webshop-english.cma-

science.nl/_clientfiles/products/CMA_Interfaces/m_002.jpg  

 

WiLab má dva analógové vstupy pre BT senzory. Pre kontrolu sa dajú použiť aj vstavaná 

LED dióda a bzučiak. Ďalšie dve LED diódy zobrazujú status pripojenia a batérie. 

Hardvérovým tlačidlom sa zariadenie zapína a vypína. 

Na prevádzku je potrebné mať počítač a program Coach 7 alebo Coach 7 Lite a pripojiť sa 

dá buď bezdrôtovo cez Bluetooth alebo USB káblom. Ďalší variant je používať ho v 

kombinácii s tabletom, kedy dáta spracúva Android aplikácia s rovnakým názvom Coach 7. 

Vstup na WiLab-e je microUSB.  

Zber dát je možný s frekvenciou až do 100 kHz pri použití jedného senzora s ukladaním do 

vnútornej pamäte. Je k dispozícií 128 kB, na ktorej sa dá uchovať 32 000 vzoriek. Meranie 

sa automaticky preruší, keď je táto pamäť vyčerpaná. Pri USB komunikácii nie je počet 

vzoriek obmedzený, keďže sa dáta ukladajú priamo do PC cez Coach 7, avšak frekvencia 

zberu nesmie prekročiť 10 000 Hz a prenos dát nesmie byť pomalší ako ich generovanie, 

čo môže závisieť aj od použitého USB kábla.  

Prostredníctvom Bluetooth komunikácie vieme rovnako zbierať dáta v reálnom čase, avšak 

s maximálnou frekvenciou 2 000 Hz pri jednom senzore a 1 000 Hz pri dvoch. Pri 

prekročení týchto limitov sa dáta ukladajú do vnútornej pamäte a platí limit 32 000 

vzoriek. (Kedzierska, 2019b) 

WiLab sa dá kúpiť na oficiálnej stránke firmy CMA za 198 eur. (CMA, 2020f) 

1.3.4 Senzory 

Firma CMA vyrába tri typy senzorov. 

https://webshop-english.cma-science.nl/_clientfiles/products/CMA_Interfaces/m_002.jpg
https://webshop-english.cma-science.nl/_clientfiles/products/CMA_Interfaces/m_002.jpg
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CMA BT (konektor British Telecom): V ponuke sú senzory zrýchlenia, vodivosti, prúdu, 

napätia, sily, magnetického poľa, pohybu, tlaku, zvuku, teploty, radiácie a mnoho ďalších. 

Všetky senzory sú pripravené na okamžité použitie. Sú kompatibilné so systémami 

VinciLab, WiLab, CoachLab II/II + a ďalšími. Cena senzorov sa pohybuje od 16 do 412 

eur za kus. (CMA, 2020a)  

ML senzory: ML senzory konvertujú namerané hodnoty do digitálnych. Používa ich iba 

systém MoLab. Ponuka senzorov je oproti BT trochu menšia. Cena sa je od 15 po 232 eur 

za kus. (CMA, 2020c)  

USB senzory: Tieto senzory sa dajú pripojiť priamo k PC bez použitia meracieho 

interfejsu. Momentálne sú to senzor pohybu a spektrometer. (CMA, 2020d) 

 

Počítačom podporované experimenty sú veľkým obohatením vyučovania fyziky, nakoľko 

nám dávajú možnosť robiť veľmi presné merania a merať aj pomerne zložité javy. Práca s 

meracími systémami tiež rozvíja digitálnu gramotnosť žiakov. Príprava a realizácia 

takýchto experimentov rozvíja spôsobilosti vedeckej práce a vie žiakov zaujať a nadchnúť. 

V ďalšej kapitole sa venujem platforme Arduino a možnostiam, ktoré nám ponúka v 

súvislosti s počítačom podporovanými experimentami.  
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2 Platforma Arduino 

Arduino je vývojová doska určená pre začiatočníkov na vytváranie interaktívnych 

samostatne funkčných objektov alebo zariadení spolupracujúcich s počítačom. Je vhodné 

pre umelcov, dizajnérov a ďalších, ktorí chcú zabudovať výpočtovú techniku do svojich 

dizajnov bez toho, aby sa najprv museli stať elektroinžiniermi. (Banzi, 2015) 

Jednoducho povedané, je to malá počítačová riadiaca jednotka, s programovateľnou 

vnútornou pamäťou, do ktorej používateľ nahrá kód, pomocou ktorého ovláda jednotlivé 

časti obvodu. 

2.1 Vznik a vízia 

Arduino vytvoril tím inžinierov v talianskom meste Ivrea v roku 2005 na báze 

mikrokontroléra ATMega. Pôvodným zámerom bolo vytvoriť platformu, s ktorou budú 

môcť študenti elektrotechniky pracovať a vytvárať svoje projekty. 

 „Keďže cieľom bolo vytvoriť rýchlo a ľahko dostupnú platformu, (autori) mali pocit, že 

najlepšie bude otvoriť projekt toľkým ľuďom, koľko bude len možné.“ (Kushner, 2011)  

Výsledkom bolo, že Arduino spravili ako open-source. „Open-source (v preklade 

„otvorený zdroj”) hardvér zdieľa veľa z princípu a prístupu voľného a open-source 

softvéru. Presnejšie, veríme, že ľudia by mali mať možnosť študovať náš hardvér a 

porozumieť ako pracuje, robiť zmeny, a zdieľať tie zmeny. Aby sme tomu pomohli, zverejnili 

sme všetky originálne dizajnové súbory (Eagle CAD) pre Arduino hardvér. Tieto súbory sú 

pod licenciou Creative Commons Attribution Share-Alike, ktorá dovoľuje osobné aj 

komerčné použitie, kým dajú kredit Arduinu a zverejnia svoje dizajny pod rovnakou 

licenciou. Arduino softvér je takisto open-source.” ( Arduino, 2020a)   

Open-source softvér je softvér dostupný na voľné použitie, originálny program môže byť 

hocikým zmenený. (Cambridge Dictionary, 2020)  

 Autori si dali za cieľ vytvoriť dostupnú platformu, ktorá by nikoho neodradila svojou 

cenou a ako strop si dali predajnú cenu 30 dolárov. „Malo to byť ekvivalentom večere s 

priateľmi v pizzérii." hovoril Massimo Banzi, hlavná postava za vznikom Arduina. 

(Kushner, 2011) 
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Dnes sa Arduino teší obrovskej popularite, pričom práve vďaka filozofii open-source môže 

ktokoľvek vytvárať a zdieľať svoje vynálezy a podporovať tak stále rastúcu komunitu 

amatérskych vynálezcov. Takisto je možné pomocou Arduina vytvárať komerčné produkty, 

tie však musia nasledovať rovnakú filozofiu (a byť pod rovnakou licenciou), teda dovoliť 

ľuďom rozoberať ich, skúmať a  upravovať podľa svojej potreby. 

2.2 Dostupnosť  

Spoločnosť Arduino LLC má oficiálnu web stránku (www.arduino.cc), kde sa dajú zakúpiť 

rôzne verzie dosky ako aj užitočné príslušenstvo. Avšak existuje aj veľké množstvo tzv. 

klonov (identických zariadení predávaných inými firmami), ktoré sa dajú kúpiť aj za menej 

ako 5 eur. V duchu svojej filozofie vám však dokonca sami tvorcovia ponúkajú možnosť 

postaviť si vlastné Arduino. Venovali tomu sekciu na svojej webstránke (Arduino, 2020d),  

kde poskytli zoznam súčiastok, schému aj návod. Všetky tieto súbory podliehajú licencii 

Creative Commons Attribution Share-Alike 2.5. 

Dosiek je mnoho verzii, líšia sa veľkosťou, výkonom a funkciami, ktoré závisia od 

pridaných komponentov. Napríklad maličká verzia Arduino Nano s rozmermi 18x45 mm, 

ktorá môže byť súčasťou drona alebo hračkárskeho robota, alebo Arduino MKR WiFi 1010 

s Wi-Fi a Bluetooth senzorom na riadenie inteligentnej domácnosti. V mojom projekte 

digitálneho teplomera používam základnú, takpovediac začiatočnícku, verziu Arduino 

UNO. 

Práca s elektronikou a vytváranie vlastných zariadení sa môže zdať človeku bez skúseností 

značne odstrašujúca, ale práve preto existujú knihy špecializované na Arduino, ktoré učia 

základy elektroniky a programovania a obsahujú podrobné návody. Obrovské množstvo 

stránok zameraných na DIY (Do it yourself / Urob si sám) ponúka návody a kreatívne 

projekty, ktoré nadšení vynálezcovia vytvorili a zdokumentovali pre ostatných, a ktoré 

dokáže nasledovať aj úplný začiatočník. Portál YouTube je plný videotutoriálov a 

inšpiratívnych projektov od ľudí z celého sveta. Na fórach (napríklad priamo na oficiálnej 

stránke https://forum.arduino.cc) môžete položiť otázku a takmer isto sa nájde niekto 

ochotný a skúsený, kto vám ju pomôže zodpovedať. Obvykle však trvá nejaký čas, kým je 

človek natoľko skúsený, aby vôbec dokázal položiť otázku, ktorá ešte zodpovedaná nie je. 

Pravdepodobne bude stačiť len pohľadať odpoveď na internete.  

https://forum.arduino.cc/
https://forum.arduino.cc/
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2.3 Doska Arduino UNO   

Definujeme niekoľko pojmov: 

• Pin – konektor. Otvor alebo kolík, kam sa pripája iný (komplementárny) konektor. 

• Input / output pin - Vstupno – výstupný pin. Znamená to, že dokáže prijímať signál 

alebo ho posielať. V kóde sa tieto dve funkcie rozlišujú príkazom, digitalRead() 

alebo digitalWrite(), analogicky pre analógový signál analogRead() a 

analogWrite(). 

• Mikrokontrolér – jednočipový počítač. Integrovaný obvod, ktorý typicky obsahuje 

flash pamäť na ukladanie kódu, a operačnú pamäť RAM na uloženie aplikačných 

premenných. 

Obr. 4 Arduino Uno,  

zdroj: https://store.arduino.cc/arduino-uno-rev3 , upravené 

 

Arduino UNO je základná doska, vhodná pre začiatočníkov. Umiestnenie jednotlivých 

prvkov vidno na obr. 4. 

https://store.arduino.cc/arduino-uno-rev3
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Z čoho sa skladá 

Opíšem niekoľko základných komponentov, s ktorými budeme pracovať. Ich polohou sa 

nebudem bližšie zaoberať, identifikovať jednotlivé piny je jednoduché, nakoľko sú 

označené skratkami priamo na doske. 

14 digitálnych pinov – dokážu prijímať alebo posielať logickú hodnotu 0 alebo 1, vo forme 

napätia LOW (0V) alebo HIGH (5V). Označené sú číslami 0 – 13. 

6 analógových  i/o pinov – dokážu posielať alebo prijať analógový signál a skonvertovať 

ho na digitálnu hodnotu, ktorú môže prečítať a spracovať mikrokontrolér. Označené sú 

číslami 0-5.  

Napájací konektor – sieťový adaptér 2.1 mm. 

USB konektor – obvykle sa jedná o konektor USB typu B, ale klony sa dajú ľahko zohnať 

aj s konektormi USB-mini, USB-micro, či USB-C. Podstatné je mať príslušný kábel, a teda 

dokázať pripojiť Arduino k PC.  

Reset tlačidlo – stlačením Reset tlačidla sa reštartuje program, ktorý na Arduine beži. Ak je 

tlačidlo nedostupné, to isté sa dá dosiahnuť pripojením vlastného Reset tlačidla na Reset 

pin.  

Napájanie 

Arduino UNO sa dá napájať z USB, externého adaptéru jednosmerného napätia alebo 

batériou. Adaptér sa dá pripojiť pomocou 2.1mm konektora na doske. Kontakty batérie sa 

dajú pripojiť na Vin (Voltage In) a GND (Ground) piny. 

Externý adaptér môže mať napätie 6 V – 20 V, odporúčaný rozsah je 7 V – 12 V. 

Pamäť 

Arduino UNO používa mikročip ATmega328 s 32 kb pamäte, z čoho 0,5 kb zaberá 

bootloader. (Arduino, 2020b) Do tejto pamäte sa nahrá kód.  

Ako sa používa 

Arduino dokáže ovládať digitálne a analógové vstupno-výstupné piny. Zapojíme teda 

obvod podľa potreby, pripojíme príslušné kontakty na piny. Energiu do obvodu dostaneme 



23 

z 5V alebo 3,3V pinu a uzatvoríme ho do pinu GND. Všetky ground (GND) piny na 

Arduine sú rovnocenné.  

Ďalší krok je nahrať do Arduina kód. Arduino musí byť pripojené do PC a 

nakonfigurované v príslušnom porte v programe Arduino IDE. Tomu procesu sa bližšie 

venujem v kapitole 3 – Softvér. Pre túto dosku treba v IDE zvoliť „Arduino/Genuino Uno”, 

a zvoliť treba port, v ktorom je pripojené Arduino (typicky je na výber iba jeden port). 

Keď je kód nahratý, čo by malo trvať niekoľko sekúnd, Arduino začne pracovať. Zastaviť 

ho môžeme odpojením od zdroja, spustiť program odznovu môžeme stlačením tlačidla 

Reset. 

2.4 Programovanie – softvér Arduino IDE 

IDE je skratka pre „Integrated Development Environment“, v preklade „Integrované 

vývojové prostredie“. Napísaný je v jazyku Java. Pôvodne vznikol z výukového prostredia 

Processing upraveného pridaním niekoškých funkcií a podporou jazyka Wiring. (Voda, 

2017 s. 23)  

Program Arduino IDE je open-source, zdrojový kód je zverejnený na stránke 

https://github.com/arduino/Arduino/ .  Je to cross-platformová aplikácia, teda pobeží na 

operačných systémoch Windows, Linux aj Mac. Používateľ v ňom napíše kód, ktorý chce, 

aby bežal na Arduine, a nahrá ho do pamäte mikrokontroléra.  

Programovať Arduino sa dá aj bez inštalovania IDE, a to prostredníctvom webového 

editoru, ktorý je ale inak takmer identický. Dá sa tiež nepoužívať žiaden Arduino softvér a 

spraviť si vlastné programy použitím AVR C alebo C++. (Arduino, 2020c) Web editor sa 

nachádza na linku https://create.arduino.cc/editor/  

 

Prostredie IDE 

Prostredie Arduino IDE (obr. 5) obsahuje textový editor na písanie kódu, oblasť správ, 

toolbar s menu a toolbar (nástrojovú lištu) s tlačidlami. 

Programy vytvorené v Arduino IDE sa nazývajú náčrty (skeče - sketches) a ukladajú sa s 

príponou .ino.  

https://github.com/arduino/Arduino/
https://create.arduino.cc/editor/
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Tlačidlami Verify a Upload sa dá kód v hlavnom okne skontrolovať a tiež nahrať do 

Arduina, v prípade, že je bez chýb a máme správne pripojenú dosku. Tlačidlá New, Open a 

Save vytvárajú, otvárajú a ukladajú skeče.  

 

Obr. 5 Okno Arduino IDE 

 

Oblasť správ dáva spätnú väzbu pri ukladaní a exportovaní a tiež zobrazuje ukazuje 

chybové hlásenia.      

Ak je funkčná komunikácia medzi doskou a programom, po kliknutí na ikonu lupy sa 

otvorí Serial Monitor (v slovenskej verzii preložené ako Monitor sériového portu). Cez 

Serial Monitor sa dá komunikovať s bežiacim programom v Arduine - posielať mu údaje, 

alebo ich preberať. Napríklad keď nám senzor niečo meria, môžeme si v Arduine hodnoty 

nechať vypisovať do sériového portu a prijaté údaje v PC zobrazovať pomocou Serial 

Monitoru (obr. 6). 

Pre zabezpečenie komunikácie je potrebné nastaviť typ dosky, ktorú používame. To sa robí 

cez  tlačidlo Tools → Board a pre Arduino UNO vyberieme možnosť Arduino/Geniuno 

UNO. 
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Obr. 6 Okno Serial Monitor v Arduino IDE 

Arduino IDE je preložené do viac ako 50 jazykov vrátane slovenčiny, zmenia sa však iba 

názvy tlačidiel a položiek menu, programovanie ostáva rovnaké. 

Programovanie  

Arduino IDE používa „jazyk” C/C++, respektíve skupinu funkcií z neho. Základná syntax 

zodpovedá C, a kód má dve hlavné časti: funkciu setup() a funkciu loop(). Obe predchádza 

slovo „void“, čo znamená, že sa bude jednať o funkciu, ktorá nevracia žiadnu hodnotu. 

Názov funkcie nasleduje dvojica okrúhlych zátvoriek "()” na parametre, ako určuje syntax 

C, a zložené zátvorky “{}“ v ktorých je telo funkcie, teda príkazy, ktoré sa majú vykonať. 

Obe tieto funkcie musia byť súčasťou programu, inak sa neskompiluje a vyhlási chybu.  

Okrem toho môžeme obdobne definovať vlastné funkcie, inicializovať premenné, či 

vkladať knižnice. 

void setup(){}  

Medzi zložené zátvorky sa v tomto bloku píše kód, ktorý sa vykoná len raz, na začiatku 

programu. To znamená po pripojení napájania, stlačení tlačidla Reset, alebo nahratí kódu 

do Arduina. V tejto časti je vhodné napríklad zadefinovať premenné, či nastaviť módy 

pinov. 

void loop(){} 

Do zložených zátvoriek funkcie loop sa píše kód, ktorý sa bude opakovať neustále dokola 

až do odpojenia napájania, reštartu, alebo nahratia nového programu. (Voda, 2018 s. 24) 
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Poznámky 

Všetok text v riadku za  

// 

 je komentár, alebo inak povedané poznámka. Program bude tento text úplne ignorovať. 

Píšu sa tam prevažne vysvetlivky ku kódu. 

Knižnice 

Knižnica poskytuje nové funkcie, napríklad na prácu so špeciálnym hardvérom, alebo 

manipuláciu s dátami. Dajú sa importovať cez Sketch → Import Library . Knižnicu do 

programu zaradí výraz  

#include  

na začiatku skeču. Knižnica sa bude kopírovať na dosku spolu s kódom, takže program 

bude v Arduine zaberať viac pamäte.  

Niekoľko základných knižníc je predinštalovaných v IDE, iné sa dajú doinštalovať 

kliknutím na Tools → Manage Libraries . Tomto procesu sa bližšie venujem v časti 3.2.3 

Inštalovanie knižníc. 

Príklady  

IDE má predpripravených niekoľko skečov ako ukážku kódu. Dajú sa otvoriť cez 

File → Examples → Build-in Examples  

Nachádza sa tam niekoľko príkladov roztriedených do kategórií, napríklad 01.Basics → 

Blink (žmurkanie), ktoré obsahuje kód, ktorý nechá Arduino v sekundovom intervale 

zapínať a vypínať vstavanú LED diódu. 

Konkrétnemu programovaniu sa venovať nebudem, nakoľko to nie je cieľom tejto práce. 

Kód, ktorý bude nahratý do Arduina pri vyrábaní digitálneho teplomera je súčasťou práce. 
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2.5 Arduino na vyučovaní 

Arduino sa dá kúpiť za pár eur a pri vytváraní projektov nám pomôže obrovská komunita 

nadšencov na internete. Je výborným spojením elektroniky a programovania, s možnosťou 

vytvárať plne funkčné produkty, kde najväčšou limitáciou sú fantázia a trpezlivosť. 

Arduino je ideálne pre záujmové krúžky, elektrotechnické školy, či vyučovanie techniky na 

druhom stupni v rámci disponibilných hodín.  

Príkladom podobného projektu je Micro:bit od britskej BBC, vytvorený ako podpora 

digitálneho vzdelávania. V roku 2016 dostalo svoj vlastný Micro:bit približne milión 

žiakov Spojeného kráľovstva. Podobne ako Arduino, je to malá programovateľná 

platforma, ktorá je ale prispôsobená deťom. Napríklad umožňuje blokové programovanie a 

má niekoľko vstavaných prvkov, ako dve tlačidlá, 5x5 px Led displej či Wi-Fi modul. Dalo 

by sa povedať, že je to zjednodušené, atraktívnejšie Arduino. 

Podobné projekty majú veľký potenciál a budúcnosť na vyučovaní informatiky či techniky, 

nakoľko sa digitálne technológie stávajú stále väčšou súčasťou nášho každodenného života 

a spoločnosť smeruje k čoraz väčšej automatizácii.  

Arduino je na vyučovaní prírodovedných predmetov tiež využiteľné v podobe meracieho 

systému. Na trhu je veľká ponuka zaujímavých senzorov. Keď nájdeme taký, ktorý nás 

zaujíma, treba zistiť ako sa zapája a či k nemu existujú knižnice. Ak áno, sme na polceste k 

meraciemu prístroju. 

Ako príklad uvediem niekoľko senzorov dostupných na stránke www.techfun.sk spolu s 

ich cenami (aktuálne k 12.2.2020).  

Fotorezistor 0,2 eur 

senzor napätia   0,7 eur 

senzor zrážok a výšky vodnej hladiny 0,9 eur 

senzor dotyku  1,1 eur 

snímač srdcového pulzu 3.5 eur 

http://www.gme.sk/
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senzor teploty  1,2 eur 

infračervený senzor prekážok  1,3 eur 

ultrazvukový senzor vzdialenosti 1,9 eur  

senzor zvuku  1,5 eur 

senzor kolízie  1,5 eur 

senzor vlhkosti a teploty  1,8 eur 

senzor pohybu  1,9 eur 

senzor vlhkosti pôdy  2 eur 

gyroskop/akcelerometer 2,8 eur 

senzor teploty a tlaku vzduchu  2,9 eur 

senzor magnetického poľa (Hallov efekt)  1,6 eur 

 

Príkladom využitia Arduina ako fyzikálneho laboratória je aj projekt uskutočnený vo 

Francúzsku na Université Paris-Sud, kedy študenti tretieho ročníka v odbore fyzika 

vytvárali vlastné experimentálne zostavy na báze Arduina. Za výhody Arduina považujú 

autori nízku cenu, flexibilitu, a hlavne jeho open-source povahu, ktorá  medzi študentami 

podnecuje zdieľanie nápadov a kreativitu. „Hlavným pedagogickým cieľom otvorených 

projektov je byť realistickým úvodom do experimentálnej fyziky: aj keď je porozumenie 

študovaného fenoménu dôležité, zameranie je viac na to, ako vykonávať vedeckú štúdiu a 

schopnosti, ktoré to vyžaduje, od konceptu experimentu po analýzu výsledkov. Študenti 

dostanú úplnú experimentálnu autonómiu a môžu si vybrať ktorú fyzikálnu tému chcú 

študovať: ich úlohou je postaviť experimentálnu zostavu od základu a zrealizovať 

experimenty podľa svojho uváženia.” (Bouquet, 2017) Študentské projekty boli napríklad 

meranie elektrickej vodivosti zmesi kovu a skla (s pomocou Arduino analógového vstupu), 

rýchlosti zvuku (s použitím elektretového mikrofónu), či magnetizácie v závislosti od poľa 

pre rôzne feromagnetické materiály (Hallov senzor).  
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O aparáte na báze Arduina píšu aj U. Sari a T. Kirindi z Tureckej Kırıkkale University. 

Vytvorili podrobný návod na experiment sledovania závislosti elektrického odporu od 

teploty a definovanie elektrického koeficientu vodiča. Svoju zostavu (obr. 7) prezentujú 

ako nízko-nákladovú alternatívu fyzíkálneho laboratória. (Sari, 2019)  

 

Obr. 7 Schéma zapojenia experimentálnej zostavy, zdroj: 

https://dergipark.org.tr/tr/download/article-file/843060  

 

 

Ako je vidieť, existuje veľa možností využiť Arduino na vyučovaní. Prekážkou využitia 

vlastnoručne vyrobených meracích prístrojov môže byť malá skúsenosť učiteľov s 

elektrotechnikou a programovaním. Preto venujem ďalšiu kapitolu mojej práce 

podrobnému návodu na zostrojenie digitálneho teplomera.  

https://dergipark.org.tr/tr/download/article-file/843060
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3 Digitálny teplomer z Arduina 

Vytvorila som dva varianty digitálneho teplomera, obidve rozpracované samostatne.  

Prvá je pre sekvenčné meranie s pripojeným PC, kedy program zaznamenáva veľa hodnôt, 

meranie je spustené tlačidlom a po skončení sa dáta zo Serial Monitoru dajú skopírovať a 

ďalej spracovávať napríklad v tabuľkovom procesore.  

Druhým variantom je autonómny teplomer. K Arduinu pripojíme okrem teplotného senzora 

aj LCD displej, na ktorom sa bude v reálnom čas zobrazovať nameraná teplota. Toto 

zariadenie nemusí byť pripojené k počítaču. Ak Arduino pripojíme namiesto k napájaciemu 

adaptéru k batérii, bude fungovať ako samostatný prístroj a dá sa zobrať kamkoľvek „do 

terénu”.  

Softvérové požiadavky sú rovnaké pre obidve verzie teplomera, hardvér sa líši dvoma 

súčiastkami. 

 

3.1 Hardvér  

Arduino Uno 

Obr. 8, základná verzia vývojovej dosky od spoločnosti Arduino sa dá kúpiť na oficiálnej 

stránke za cca 20 eur, rôzne klony (funkčne rovnocenné) sa dajú kúpiť aj na Slovensku na 

stránke https://www.gme.sk/klon-arduino-uno-r3-atmega328p-ch340-mini-usb 

alebo prostredníctvom portálu Ebay za cca 5  eur.  

 

Obr. 8 Doska Arduino UNO, zdroj: https://store.arduino.cc/arduino-uno-rev3 

https://www.gme.sk/klon-arduino-uno-r3-atmega328p-ch340-mini-usb
https://store.arduino.cc/arduino-uno-rev3
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Kábel na pripojenie Arduina k PC cez USB. 

Kábel je obvykle dodávaný priamo s Arduinom. Ak nie, treba si ho zohnať podľa 

konektora na Arduine. Najrozšírenejšie sú varianty s USB-mini, USB-micro, a USB typu 

B. USB káble sa navzájom líšia iba konektorom, inak sú úplne rovnocenné. 

Breadboard – Kontaktné pole 

Obr. 9, doska na pospájanie častí obvodu. Breadboard použitý v mojej schéme, a tiež ten na 

obrázku 9, má spojené kontakty pozdĺž červenej a modrej čiary, a potom vnútri dosky 

kolmo, vždy po piatich. Dostupné na: https://techfun.sk/produkt/nepajive-pole-400-bodov/  

 

Obr. 9 Kontaktné pole, zdroj: https://www.circuitspecialists.com/wb-801.html 

Senzor teploty DS18B20 

Dostupný na: https://techfun.sk/produkt/samostatny-senzor-teploty-ds18b20/ 

Senzor DS1820 meria teplotu termistorom, teda súčiastkou, ktorá mení svoj odpor v 

závislosti od teploty. Túto informáciu v sebe senzor spracuje pomocou zabudovaného 

mikročipu a cez dátový pin pošle Arduinu v podobe binárneho kódu. Teda nie hodnotu 

napätia, ale už vyhodnotené číslo, s ktorým ďalej v Arduine pracuje knižnica 

DallasTemperature. Tento tepelný senzor sa dá zohnať ako samostatný čip, alebo vložený 

do kovovej tyčky s káblom. Odporúčame používať druhý typ, nakoľko je odolnejší.  

Podľa datasheetu k tejto súčiastke, 

rozmedzie teplôt je -55°C až 125°C  

presnosť v intervale -10°C až 85°C je  ±0.5°C 

(Maxim Integrated Products, 2019) 

https://techfun.sk/produkt/nepajive-pole-400-bodov/
https://www.circuitspecialists.com/wb-801.html
https://techfun.sk/produkt/samostatny-senzor-teploty-ds18b20/
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Obr. 10 Senzor teploty DS1820, 

zdroj:  https://lastminuteengineers.com/ds18b20-arduino-tutorial/ 

Na obr. 10 sú dva varianty, spolu s popisom kontaktov. GND sa zapája na ground, VDD na 

napájací zdroj, v našom prípade na pin +5V na Arduine. DQ označuje dátový vodič. 

(LastMinuteEngineers, 2020) 

 

Rezistory  

4.7 kΩ  

10 kΩ 

220 Ω 

Farebné kódy vidno na obr. 11. 

 

Obr. 11 Farebné kódy rezistorov, zdroj: http://resisto.rs  

Vodiče 

Obr. 12. Dostupné na: https://techfun.sk/produkt/kabliky-40-kusov-30-cm-m-m/  

Obr. 12 Vodiče, zdroj: https://www.exploringarduino.com/wp-

content/uploads/2013/05/45040-dscn0624-400x300.jpg  

 

https://lastminuteengineers.com/ds18b20-arduino-tutorial/
http://resisto.rs/
https://techfun.sk/produkt/kabliky-40-kusov-30-cm-m-m/
https://www.exploringarduino.com/wp-content/uploads/2013/05/45040-dscn0624-400x300.jpg
https://www.exploringarduino.com/wp-content/uploads/2013/05/45040-dscn0624-400x300.jpg
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LCD display 16x2 – použité vo variante 2 (digitálny ukazovateľ teploty) 

Obr. 13. Dostupné na: https://techfun.sk/produkt/display-lcd-16x2-tmavomodre-

podsvietenie/  

 

Obr. 13 16x2 LCD displej, zdroj: https://www.diyelectronics.co.za/store/6765-

thickbox_default/lcd-display-16x2-white-on-blue.jpg  

 

Tlačidlo – použité vo variante 1 (sekvenčné meranie teploty) 

Obr. 14. Dostupné na: https://techfun.sk/produkt/tlacidlo-s-nasadou/ 

 

Obr. 14 Tlačidlo, zdroj: https://electrosome.com/wp-content/uploads/2012/12/Push-Button-

Switch.jpg     

3.2 Softvér 

• Arduino IDE 

• Dallas Temperature (Arduino knižnica) 

• One Wire (Arduino knižnica) 

 

3.2.1 Inštalácia Arduino IDE 

Prostredie Arduino Integrated Development Environment (Integrované vývojové prostredie 

Arduino) si stiahneme zo stránky https://www.arduino.cc/en/Main/Software 

https://techfun.sk/produkt/display-lcd-16x2-tmavomodre-podsvietenie/
https://techfun.sk/produkt/display-lcd-16x2-tmavomodre-podsvietenie/
https://www.diyelectronics.co.za/store/6765-thickbox_default/lcd-display-16x2-white-on-blue.jpg
https://www.diyelectronics.co.za/store/6765-thickbox_default/lcd-display-16x2-white-on-blue.jpg
https://techfun.sk/produkt/tlacidlo-s-nasadou/
https://electrosome.com/wp-content/uploads/2012/12/Push-Button-Switch.jpg
https://electrosome.com/wp-content/uploads/2012/12/Push-Button-Switch.jpg
https://www.arduino.cc/en/Main/Software
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Stiahneme si verziu pre náš operačný systém a nainštalujeme ju. Spustíme Arduino IDE.  

Ďalší krok, nastavenie komunikácie medzi PC a doskou Aduino, sa líši pre rôzne operačné 

systémy. Uvedieme štandardné riešenie pre Linux a Windows. 

 

Windows 8.1 a novšie 

Pripojíme Arduino do PC pomocou USB kábla. 

Nastavíme v prostredí IDE našu dosku. Klikneme na  

Tools → Board: → Arduino/Genuino Uno 

Vyberieme port na ktorý je pripojené Arduino 

Tools → Port → COM6 

Tu treba vybrať správny port, ak je na výber iba jeden, COM a čislo, to je ten správny. V 

prípade, že ich máme viac, alebo pracujeme s viacerými Arduinami, stačí Arduino 

odpojiť/zapojiť, a pozrieť sa, čo sa v ponuke zmenilo. 

Teraz je čas otestovať, či naše PC komunikuje s Arduinom.  

 

Linux (testované na Xubuntu 18.04.3 LTS) 

Pre inštaláciu stači rozbaliť .tar.gz súbor, ktorý stiahneme z hore uvedeného linku, a po 

rozbalení spustiť skript Install.sh. Do terminálnu napíšeme: 

cd */cesta do priečinka so skriptom/* sudo sh Install.sh  

a samozrejme heslo. 

Pre fungovanie komunikácie s Arduinom treba ešte pridať príkazy: 

sudo usermod -a -G tty *username* 

sudo usermod -a -G dialout *username* 

kde za *username* treba napísať meno aktuálneho používateľa. 
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Toto zabezpečí, že je používateľ pridaný do skupín dialout a tty, a bude mať práva 

komunikovať s Arduinom cez príslušný port. Môže byť potrebné odhlásiť sa, prípadne 

reštartovať PC. 

 

3.2.2 Test komunikácie Arduina s našim PC cez USB port 

Vyberieme si ukážku programu kliknutím na  

File → Examples → 01. Basics → Blink 

Objavil sa nám v okne jednoduchý kód. Nahráme ho do Arduina kliknutím na tlačidlo 

UPLOAD. 

Ak sa neobjavila žiadna chyba, je naša doska pripojená, a pripravená na použitie. Maličká 

LED dióda na Arduine by mala blikať jedenkrát za sekundu. 

Ak sa chyba objavila, nevieme poskytnúť univerzálne riešenie. Arduino IDE je open source 

softvér a neustále sa vyvíja, rovnako ako hardvér a operačné systémy. Nekompatibilita 

môže nastať, avšak je vysoko pravdepodobné, že už ju niekto na internete vyriešil, stačí to 

dohľadať. My ďalej predpokladáme, že Arduino je pripojené a schopné komunikácie. 

3.2.3 Inštalovanie knižníc 

Máme nainštalované Arduino IDE, ale na prácu s teplotným senzorom (DS1820), ktorý 

budeme používať, budeme potrebovať ešte dve knižnice: Dallas Temperature a OneWire. V 

tomto kroku potrebujeme byť pripojení na internet. Klikneme na  

Sketch → Include Library → Manage Libraries 

Otvorilo sa nám nové okno Library Manager. Do vyhľadávacieho okna napíšeme Dallas 

Temperature  a klikneme na tlačidlo Install prislúchajúce výsledku s návom Dallas 

Temperature. 

Postup zopakujeme pre knižnicu OneWire. 

Prostredie máme pripravené, môžme začať tvoriť konkrétny projekt. 
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3.3 Sekvenčné meranie teploty 

Prvá verzia digitálneho teplomera je zariadenie na meranie teploty počas časového 

intervalu. Meranie sa spúšťa a zastavuje stlačením tlačidla a namerané hodnoty sa vypisujú 

do Serial Monitoru, ktorý je súčasťou Arduino IDE. Odtiaľ ich používateľ môže odčítavať, 

alebo po skončení merania skopírovať a používať ďalej podľa potreby.  

Formát, v ktorom sa hodnoty zobrazujú v Serial Monitore, bude nasledovný: 

čas   teplota 

Nové meranie prebehne približne každých 300 milisekúnd, tento interval sa dá predĺžiť 

zvýšením premennej vo funkcii delay().  

 

Hardvér: 

• Arduino Uno  

• breadboard  

• tlačidlo 

• káble 

• DS1820 (senzor teploty) 

• USB kábel k Arduinu 

• 4.7 kΩ rezistor 

• 10 kΩ rezistor 

 

Súčiastky zapojíme podľa schémy na obr. 15. 
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Obr. 15 Schéma variantu 1 

 

 

Priamo na Arduino pôjdu štyri káble. 5V a GND podľa schémy zapojíme do breadboardu. 

Na pin 2 zapojíme stredný (dátový) kontakt teplotného senzora, a pomocou 4,7 kΩ 

rezistora na 5V. Na pin 7 tlačidlo, rezistor použitý pri tlačidle má 10 kΩ. 

Ďalším krokom je vytvorenie programu v Arduino IDE. 

Kód sa nachádza v prílohe, alebo na:  

http://davinci.fmph.uniba.sk/~kundracik1/arduino/arduino_teplomer.html  

ako variant 1. Po nahratí kódu do Arduina otvoríme Serial monitor, buď klávesovou 

skratkou Ctrl + Shift + M , kliknutím na ikonu lupy alebo kliknutím na  

Tools →  Serial Monitor 

Po stlačení tlačidla sa začnú objavovať hodnoty (obr. 16). Obr. 16 obsahuje ešte číslo 

meraného údaju, takýto výpis sa dá zapnúť odkomentovaním jedného riadku v programe.  

Ďalšie stlačenie tlačidla meranie zastaví, program je pripravený začať nové meranie s 

časom od nuly (toto si však používateľ môže prepísaním kódu zmeniť podľa aktuálnej 

potreby).  

Dáta sa zo Serial Monitoru dajú jednoducho skopírovať, používateľ s nimi môže naložiť 

ako uzná za vhodné, uložiť do textového súboru, alebo z nich vytvoriť graf v tabuľkovom 

procesore. 

 

http://davinci.fmph.uniba.sk/~kundracik1/arduino/arduino_teplomer.html
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Obr. 16 Hodnoty namerané senzorom teploty v Serial Monitore 

 

Obr. 17 Zapojenie variantu 1 

Časté problémy: 

teplomer ukazuje -127 stupňov 

Riešenie: zlý kontakt na tepelnom senzore, treba skontrolovať ako sú súčiastky pripojené. 

Dobrý spôsob, ako sa vyhnúť tejto chybe, je priletovať kontakty senzora na hrubší káblik, s 

ktorým sa bude ľahšie manipulovať a nebude vypadávať z breadboardu.  
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Meranie nezačalo / neprerušilo sa  

Riešenie: tlačidlo nezaregistrovalo zmenu, treba ho stlačiť silnejšie. 

3.4 Digitálny teplomer 

Druhá verzia teplomera využíva LCD displej, na ktorý sa zobrazuje aktuálna hodnota 

nameraná senzorom. Dôležitá výhoda tohto zapojenia je, že po prvotnom nahratí kódu do 

Arduina už nebudeme počítač potrebovať. Ak pripojíme Arduino na externý zdroj napätia, 

môžme si teplomer zobrať do terénu. 

Hardvér: 

• Arduino Uno  

• breadboard  

• káble 

• DS1820 (senzor teploty) 

• USB kábel k Arduinu 

• 2x 4.7 kΩ rezistor 

• 220 Ω rezistor 

• LCD displej 16x2 

 

Zapojenie LCD displeja: 

Displej má 16 pinov, ktoré majú rôznu funkciu. Prácu väčšiny z nich za nás bude riadiť 

knižnica LiquidCrystal, avšak dôležité je správne ich zapojiť. 

Zľava doprava sú to:  

 

GND uzemnenie displeja 

5V napájanie displeja z napätia 5V 

Kontrast podľa napätia na tomto pine bude display zobrazovať 
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text. Príliš vysoký odpor spôsobí nevýrazné písmená, a 

príliš nízky biele obdĺžniky. 

RS (Register select) kontrolný pin, ktorý za nás bude riadiť knižnica 

LiquidCrytal. Posiela binárne buď 0 = nastavujeme 

kurzor, alebo  1 = vypisujeme na display 

RW (Read / write) 1 alebo HIGH (alebo napätie) na tomto pine znamená 

čítanie z registrov, a 0 znamená písanie. My chceme len 

písať, pin pripojíme na GND.  

E (enable writing to registers) zabezpečuje komunikáciu displeja s knižnicou.  

D0 - D7 - 8 bitov ktorými posielame znaky v ASCII kóde (8 núl 

alebo jednotiek). Dá sa používať 8 bitový alebo iba 4 

bitový, kedy každý pin musí poslať dva bity informácie, 

a je teda pomalší. Nám bude stačiť 4-bit. 

Anóda Zabezpečujú intenzitu podsvietenia displeja 

Katóda 

 

(Electronicsforu, 2018) 

Obr. 18 Schéma variantu 2 
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Zapojíme súčiastky podľa obr. 18. Dva rezistory sú 4.7 kΩ, a rezistor na anóde (úplne 

napravo) je 220 Ω. Farebné kódy rezistorov na obrázku sú správne. Program sa nachádza 

opäť v prílohe a na  

http://davinci.fmph.uniba.sk/~kundracik1/arduino/arduino_teplomer.html   

Ako variant 2. Nahráme ho do Arduina, a teplota by sa mala začať zobrazovať na displeji. 

 

Obr. 19 Zapojenie variantu 2 

 

Na obr. 19 možno vidieť hotové zariadenie. Dá sa používať ako externý teplomer. Arduino 

pripojené k PC berie energiu z PC cez USB, ale ak by sme ho pripojili na iný zdroj napätia, 

bude naďalej merať teplotu, keďže na svoje fungovanie už PC vôbec nepotrebuje.  

 

Časté problémy: 

teplomer ukazuje -127 stupňov 

Riešenie: zlý kontakt na tepelnom senzore, treba skontrolovať ako sú súčiastky pripojené. 

Dobrý spôsob ako sa vyhnúť tejto chybe je priletovať kontakty senzora na hrubší káblik, s 

ktorým sa bude ľahšie manipulovať, a nebude vypadávať z kontaktného poľa.  

Displej nič nezobrazuje, displej zobrazuje biele obdĺžniky 

http://davinci.fmph.uniba.sk/~kundracik1/arduino/arduino_teplomer.html
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Riešenie: pravdepodobne chybne zapojený pin na nastavenie kontrastu. Treba 

skontrolovať, či má správny odpor, alebo skúsiť použiť iný rezistor. 

Displej má nevhodný jas 

Riešenie: treba vymeniť rezistor pri anóde. Aj tie isté displeje, tak povediac z tej istej 

továrne, môžu mať rôzne vlastnosti a vhodný rezistor pre jednu súčiastku nemusí byť 

ideálny pre druhú súčiastku.   
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4 Využitie digitálneho teplomera na vyučovaní 

Podľa Štátneho vzdelávacieho programu by sa mali žiaci základných škôl na Slovensku v 

siedmom ročníku venovať téme teplo, teplota, a premeny skupenstva látok. 

4.1 Teplomer na sekvenčné meranie  

Súčasťou obsahového štandardu pre 7. ročník pre témy Teplota. Skúmanie premien 

skupenstva látok je okrem iného: 

• meranie času 

• meranie teploty v priebehu času 

• graf závislosti teploty od času 

• využitie PC pri zostrojovaní grafov 

• var, teplota varu,  

• graf závislosti teploty od času pri vare vody 

(ŠPÚ, 2014) 

Na naplnenie vzdelávacích cieľov v tejto oblasti, na vyučovaní necháme žiakov v 

skupinách vykonať nasledujúci experiment. 

Experiment 1: Meriame teplotu vody v rýchlovarnej kanvici 

Cieľ: 

Merať teplotu vody v priebehu jej zohrievania a počas varu. Zistiť, ako sa správa teplota 

vody pri jej vare a aký priebeh má graf závislosti teploty od času pri vare kvapaliny.  

Pomôcky:  

• teplomer na sekvenčné meranie pripojený do PC 

• rýchlovarná kanvica 

• voda 

Postup: 

1. Teplotný senzor vložíme do vody v rýchlovarnej kanvici. 

2. Pripravíme si prostredie Arduino IDE a otvoríme Serial Monitor. 

3. Zapneme meranie stlačením tlačidla na teplomeri. 

4. Zapneme rýchlovarnú kanvicu. 
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5. Necháme meranie spustené, kým voda nedosiahne var, a potom ešte približne pol 

minúty.  

6. Zastavíme meranie stlačením tlačidla, vypneme rýchlovarnú kanvicu. 

Experimentálnu zostavu s teplomerom možno vidieť na obr. 20. 

 

Spracovanie dát: 

Dáta skopírujeme zo Serial Monitoru, máme dvojice: čas merania a hodnotu teploty v 

stupňoch Celzia (obr. 21). V programe Microsoft Excel, prípadne v inom procesore, z 

týchto hodnôt vykreslíme graf (obr. 22). 

 

Doplňujúce otázky: 

1. Prečo sa čiara grafu nezačína v bode so súradnicami [0, 0]? 

2. Aký je vzťah medzi časom a teplotou pri zohrievaní vody? 

3. Približne za aký čas by voda dosiahla teplotu 90 °C? 

4. Kde v praxi je dôležité sledovať závislosť teploty od času? 

5. Čo sa deje v kvapaline pri vare? Prečo teplota kvapaliny nestúpa?  

       (Velmovská, 2015 s. 109 -110) 

Realizácia s Arduino teplomerom 

 

Obr. 20 Zostava experimentu 1 
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Obr. 21 Namerané hodnoty z experimentu 1 v Serial Monitore 

 

 

Obr. 22 Graf vytvorený z nameraných hodnôt v experimene 1 

4.2 Externý teplomer  

Ako ukážku aktivity pre využitie druhej verzie digitálneho teplomera máme aktivitu z témy 

teplo. Podľa štátneho vzdelávacieho programu pre 7. ročník základnej školy patrí do 

obsahového štandardu v téme teplo aj: 
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• odovzdávanie a prijímanie tepla telesom 

• kalorimeter 

• výsledná teplota pri výmene tepla medzi horúcou a studenou vodou 

• rozdiel dvoch teplôt (∆t) 

• tepelná rovnováha 

• hmotnostná tepelná kapacita, značka c, jednotka J/kgoC teplo, značka Q, jednotka 

tepla J,  

• vzťah Q = c ∙ m ∙ ∆t 

(ŠPÚ, 2014) 

 

Experiment 2: Miešame horúcu a studenú vodu 

Cieľ: 

Odhadnúť a následne meraním zistiť výslednú teplotu pri zmiešavaní horúcej a studenej 

vody. 

Pomôcky: 

• digitálny teplomer 

• odmerný valec 

• jednoduchý kalorimeter 

• rýchlovarná kanvica 

Postup: 

1. Dobre si preštuduj tabuľku a dbaj na pokyny vyučujúceho. Dôležité je vykonanie 

odhadov pred meraním v predposlednom stĺpci tabuľky. 

2. Prvé tri merania urob podľa pokynov v tabuľke. Studená voda môže mať teplotu vody z 

vodovodu. 

3. V meraní č. 4 a 5 si sám urči množstvo a teplotu horúcej vody. Ber však do úvahy, koľko 

vody sa do jednoduchého kalorimetra zmestí. 

4. Pri každom meraní postupuj tak, že najskôr dáš do kalorimetra studenú vodu, a až potom 

naleješ horúcu vodu. Spodnú časť kalorimetra zakry vrchnou časťou a chvíľu počkaj na 

ustálenie teploty. 

5. Prv než odmeriaš výslednú teplotu, odhadni, aká asi bude. Svoj odhad napíš do 6. stĺpca 

tabuľky. 

6. Odmeraj výslednú teplotu vody a zapíš ju do tabuľky (obr. 23).  

(Lapitková, 2010 s. 112) 
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Obr. 23 Tabuľka k experimentu 2,  

zdroj: Lapitková, učebnica pre 7. ročník ZŠ s. 71 

 

Doplňujúce otázky  

1. Svoj odhad výslednej teploty porovnaj so skutočne nameranou teplotou. Sú tvoje odhady 

a namerané hodnoty približne zhodné? V ktorom meraní sa tvoj odhad a skutočne 

nameraná hodnota najviac zhodujú? V ktorom meraní si sa najviac pomýlil? 

2. Ako si odhady robil? Opíš postup. 

3. Od čoho závisí výsledná teplota pri zmiešavaní horúcej a studenej vody? 

4. Aké chyby merania ovplyvnili nameranú výslednú teplotu? 

(Velmovská, 2015 s. 144 – 146) 

 

Realizácia s Arduino teplomerom 

Na obr. 24 a), b), c) je experimentálna zostava s digitálnym teplomerom. Teplomer bol 

postupne ponorený do pohárov s rôznou teplotou vody, hodnoty teploty sa zobrazujú na 

LCD displeji. 
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Obr. 24 a), b), c)  Zostava experimentu 2 

 

4.3 Výhody Arduino teplomeru 

Veľa škôl používa na vyučovaní na meranie teploty liehové teplomery. Pri experimente s 

rýchlovarnou kanvicou je potrebné neustále sledovať a zapisovať hodnoty. Je potrebná 

presná koordinácia viacerých žiakov, aby dokázali odsledované hodnoty presne priradiť k 

času, a treba to robiť počas niekoľkých minút. Automatizácia tohto merania dáva možnosť 

získať väčšie množstvo dát, nehovoriac o presnosti merania. Okrem priradenia časového 

údaju vieme určiť zmeny teploty s rozlíšením na stotinu stupňa, čo je na liehovom 

teplomeri ťažko realizovateľné. „Pri meraniach pomocou senzorov dosahujeme zvyčajne 

oveľa väčšiu presnosť, čo vzbudzuje v žiakoch väčšiu dôveru k výsledkom merania.” 

(Demkanin, 2006 s. 8) 
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Oproti použitiu meracích systémov Coach sa môže zdať náš teplomer menej estetický a 

vyžaduje, aby sme dáta spracovali sami. Na druhej strane, nemusíme sa oňho báť a vieme 

mať vždy dostatok teplomerov pre celú triedu. A na koniec, pre žiakov môže byť poučné 

vidieť dovnútra meracieho zariadenia a vedieť si vytvoriť, prípadne nafitovať vlastný graf.  
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Záver 

V tejto práci som analyzovala význam počítačom podporovaných experimentov na 

vyučovaní fyziky. Urobila som stručný prehľad dostupných meracích systémov Coach a 

ponúkla alternatívu v podobe meracieho systému na báze Arduino. Druhá kapitola sa 

venovala Arduinu a jeho potenciálu na vyučovaní, a tiež zahraničným projektom, ktoré 

využívajú Arduino vo fyzike. Tretia kapitola pozostáva z podrobného návodu na 

zostrojenie digitálneho teplomera, spolu so zoznamom súčiastok, popisom funkcionality a 

potrebnými krokmi pre zapojenie teplomera. Štvrtá kapitola ukazuje dva experimenty z 

učebnice fyziky pre 7. ročník ZŠ, zrealizované s digitálnym Arduino teplomerom.  

Záverom je, že fyzikálne laboratórium s pomôckami zostrojenými z Arduina je možná 

alternatíva pre ľudí ochotných skúsiť niečo nové a dať do toho trochu vlastného úsilia.   
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Prílohy 

1. Kód pre sekvenčné meranie teploty 

Komentáre sú za “//“ a nie sú potrebné pre fungovanie programu. Slúžia len na vysvetlenie 

funkčnosti jednotlivých častí. 

 

#include <OneWire.h> 

#include <DallasTemperature.h> 

// zavoláme knižnice, ktoré budeme používať 

 

#define ONE_WIRE_BUS 2 

OneWire oneWire(ONE_WIRE_BUS); 

DallasTemperature sensors(&oneWire); 

// tieto príkazy volajú moduly z knižníc. Číslo 2 v #define 

ONE_WIRE_BUS označuje číslo pinu na Arduine, kam sme zapojili 

senzor. 

 

// definovanie premenných: 

  int n = 1;          // bude počítať merania 

  int x = 0;  // bude kontrolovať zapnutie a vypnutie spolu s 

tlačidlom 

  int buttonPin = 7;  // označuje Arduino pin, kam sme 

pripojili tlačidlo 

  int B_read;   // do tejto premennej budeme ukladať hodnotu 

z tlačidla HIGH alebo LOW 

  float c,cas,T;    // c a cas budú na zaznamenanie času, v 

ktorom sme namerali údaj, a T bude nameraná hodnota teploty. 

 

void setup(void){   

  // zapneme Serial monitor, ktorý nám bude zobrazovať 

hodnoty 

  Serial.begin(9600); 

  // zapnutie senzorov, príkaz z knižnice 

  sensors.begin(); 

 pinMode(buttonPin, INPUT); 

// premennná buttonPin, ktorá má číslo 7 (pin na Arduine, kam 

sme zapojili tlačidlo) sa nastaví na INPUT – prijímanie 

signálu z tlačidla. 

} 

 

void loop(void){  

  B_read = digitalRead(buttonPin); 

  // do premennej B_read uložíme hodnotu prečítanú z 

tlačidla. HIGH znamená stlačené tlačidlo, LOW nestlačené. 
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  if (B_read == HIGH) { 

     

              if (x == 1) {x = 0; Serial.println("Koniec 

merania");} // prepneme hodnotu kontrolnej premennej 

              else { 

       x = 1;    

       Serial.println("začiatok merania+"); 

       T = millis()/1000.0;  // T je hodnota funkcie millis() 

na začiatku merania, používame ju ako referenčnú, a 

prepočítavame rovno do sekúnd 

       n = 1;     // n zobrazuje počet meraní 

         } 

              delay(300); // delay zabezpečí, že 300 

milisekúnd tlačidlo nebude reagovať, aby sme meranie okamžite 

nezrušili.  

             }              

  if (x == 1) {  // podmienka je splnená ak bolo tlačidlo 

stlačené na zapnutie merania 

     cas = millis()/1000.0;  // v premennej cas je hodnota v 

sekundách 

    c = (cas-T);  // od cas odopčítame referenčnú hodnotu zo 

začiatku merania 

     sensors.requestTemperatures();   

   //  Serial.print(String(n) + "       ");    // po 

odkomentovani tohto riadku bude program vypisovat aj cislo 

merania 

     Serial.print(String(c) + "        "); // vypíšeme do 

riadku hodnoty čísla merania a času  

    Serial.println(sensors.getTempCByIndex(0)); // do serial 

monitoru vypíšeme hodnotu zo senzora 

             delay(100); 

    n++;  // zväčšíme n, môže prísť ďalšie meranie 

              } 

}  
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2. Kód pre digitálny teplomer 

#include <OneWire.h> 

#include <DallasTemperature.h> 

#include <LiquidCrystal.h> 

// zavoláme knižnice, ktoré budeme používať. Knižnica 

LiquidCrytal je automaticky súčasťou Arduino IDE. 

#define ONE_WIRE_BUS 1 

OneWire oneWire(ONE_WIRE_BUS); 

DallasTemperature sensors(&oneWire); 

// tieto príkazy volajú moduly z knižníc. Číslo 1 v #define 

ONE_WIRE_BUS označuje číslo pinu na Arduine, kam sme zapojili 

senzor. 

 

LiquidCrystal lcd(12, 11, 5, 4, 3, 2); 

// tento príkaz konfiguruje LED display, čisla v zátvorke sú 

čísla príslušných pinov na Arduine, kam sme podľa schémy 

pozapájali kontakty displeja. 

String str; // budeme používať jednu premennú str, typu 

String 

 

void setup(void) 

{ 

  sensors.begin(); 

  lcd.begin(16, 1); 

// zapne zobrazovanie na displeji, 16 znakov, 1 riadok 

} 

 

void loop(void){  

   

     sensors.requestTemperatures();    

     str = String(sensors.getTempCByIndex(0)) + " C"; 

// do premennej str sme uložili hodnotu zo senzora 

skonvertovanú na typ string, a pridali číslo C, ako jednotku 

stupňov Celzia 

     lcd.setCursor(0,0);  // kurzor sa nastaví na prvý znak v 

prvom riadku (súradnice 0,0) 

    lcd.print(str);      // zobrazenie premennej str na 

displeji 

    delay(100); 

              } 
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3. Detail zapojenia, sekvenčné meranie: 
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4.  Detail zapojenia, externý teplomer: 

  


